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Request for Applications—Adult Education Providers 2021
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1. FYI--The following boxes on page 16 or 17 do not work. Will we be given a different RFA or are we able to begin entering basic information on the downloadable RFA in the NMHED website?

A: A Word Document of the RfA was placed on the NMHED website on March 2, 2021,  This should solve the issue of a non-fillable PDF.  

Received: Thursday, March 4, 2021
2. Will the applicant need to submit the application to our LWDB prior to submission to the state on 4.9.21, or will the review team/state office submit the applications to the LWDB?

A: NMHED AE will submit all applications received to the appropriate LWDB following the submission deadline of April 9, 2021.  The LWDB will then review them at that time.  Applicants do not need to submit anything directly to the LWDB as part of the application process.

3. On page 11 the RFA lists three definitions for employment outcomes – which metric are applicants to use to complete the chart on pg 11?

A: The table on page 11 is part of the Demonstrated Effectiveness section of the RFA, in which an otherwise eligible provider must demonstrate effectiveness in order for the rest of their application to be considered. NMHED seeks as many applicants as possible for this competitive grant. We want to be inclusive of all potentially eligible providers. In this table, you may choose the employment outcome metric(s) that are relevant to the data your program has collected and analyzed over the last three fiscal years. In or under the table, tell us the metric(s) you are using so that we can understand your data. Remember that your response should help equip us if we choose to examine your data. 

4. Employment outcomes are on a lag – for FY 18 is the RFA asking for employment outcomes for the students who were served in FY18, or what was reported on NRS Table 5 for FY 18 which would be a combination of students from FY17 & FY18?
A: NMHED seeks as many applicants as possible for this competitive grant. We want to be inclusive of all potentially eligible providers, whether or not they have been previously funded under Title II of WIOA. In this table, you may choose to report your data in the way that your program has collected and analyzed it over the last three fiscal years. For the purposes of this table, we are not concerned with whether the data was reported on an NRS Table. In or under the table, describe the metrics and outcomes you are using so that we can understand your data. Remember that your response should help equip us if we choose to examine your data. 
5. Are applicants to include reading and writing subtests for students served in English Language Acquisitions programs or just include subtests for reading and writing for students served in ABE/ASE programs?
A: NMHED seeks as many applicants as possible for this competitive grant. We want to be inclusive of all potentially eligible providers, whether or not they have been previously funded under Title II of WIOA. In this table, you may choose to report your data in the way that your program has collected and analyzed it over the last three fiscal years. In or under the table, describe the outcomes you are using so that we can understand your data. Remember that your response should help equip us if we choose to examine your data. 

6. Should applicants include students served in IET programs in the transition to postsecondary education and training metric?
A: NMHED seeks as many applicants as possible for this competitive grant. We want to be inclusive of all potentially eligible providers, whether or not they have been previously funded under Title II of WIOA. In this table, you may choose to report your data in the way that your program has collected and analyzed it over the last three fiscal years. In or under the table, describe the outcomes you are using so that we can understand your data. Remember that your response should help equip us if we choose to examine your data. 
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7. Will the effects of the COVID Pandemic be taken into consideration when agencies report their outcomes and 3-year average as it will have a negative impact?

A: Yes. We are aware that all programs have been inevitably impacted by the pandemic, and that some have been more impacted than others based on their locations and other factors. Please report your outcomes nonetheless and know that we are aware of pandemic-related impacts. 

8. Should RFA program descriptions reflect pandemic scenarios (virtual) or post-pandemic when instruction is back to normal operations (in-person learning)? Or both?
A:  We do not yet know how the pandemic will evolve and how it will continue to affect our programs. As such, please reflect your current, pandemic-related scenarios as well as your plans for the future, to the extent that you are able to make them. In other words, the answer is “both.”

9. During the pandemic, virtual services were extended to other service areas that were not operating. Will this practice continue to be allowable?
 
A: It seems to me that this question is only partially related to the RFA. To the extent that it pertains to the RFA, please assume that what is allowable now will continue to be allowable, as we do not know how the pandemic will evolve and how it will continue to affect our programs. 

10. There is a discussion on the State’s proposed reorganization of the boards. What impact will this have on the WIOA policies and procedures that have already been developed per region as well as the MOU’s?

A: To the extent that this question pertains to the RFA, use the regional plans currently posted by the Workforce Investment Board in your region to inform your responses in the narrative section of your application. For clarification on the needs and priorities in your area, reach out directly to the individual(s) listed in the RFA for that region. Any proposed future reorganization of the boards is not pertinent to this application; please refer to the existing regional plans so that everyone in a region has access to and refers to the same information. 

11. Formatting Question - How would you like us to format citations? In-text, Footnotes, Endnotes? Will the citations be excluded from the word count?
A: Citations will be excluded from the word count.  Please be consistent and use a recognized format (e.g. APA format), but otherwise NMHED AE has no preference to citation format. Generally speaking, if you cite a publication, we may choose to find and read that publication, so it is important that you provide the full reference to any source you cite.

12. If we have letters of support can those be added as an appendix?
A: We did not ask for letters of support in the RFA. Therefore, in order to ensure a fair competition among all applicants, please do not append letters of support to your application; we will not read them.
 
13. Wanting to confirm this is a separate grant from and does not directly impact the State's Adult Literacy funding.
A: That is correct.  These are two separate funding opportunities and separate funding streams. They do not impact each other.
14. Can pre-prosecution diversion, drug court participants, and programs for individuals exiting the detention center be considered "corrections programs" under the funding definitions outlined by WIOA Section 225?
A: The answer to your question is likely no; however, there are several things to consider. The funds must be used for the cost of educational programs for criminal offenders in correctional institutions and for other institutionalized individuals. Our understanding is that the scenarios you refer to in your question are all examples in which learners would not be in correctional institutions or other similar institutions. The definitions for these institutions are listed in part (e) of the item in question: ( A) prison; (B) jail; (C) reformatory; (D) work farm; (E) detention center; or (F) halfway house, community-based rehabilitation center. We do not believe the programs you are referring to qualify as one of the institutions in the aforementioned list. However, please keep in mind that where the individual sleeps at night is a factor in using funds for 225. Therefore, “programs for individuals exiting the detention center” could quality for section 225 funds, depending on the nature of that program. If learners sleep in any of the institutions listed above in the lettered list, then they can access section 225 funds. Please be aware that other AEFLA funds (other than section 225 funds) may be used to serve otherwise eligible individuals in the situations you describe in your question. 
15. If the single audit has not been approved by the state, will you accept FY19 and FY18 audits?
A: Yes.  If your institution’s most recent audit has not yet been approved, we will accept your two most recent approved audits.

16. Can we turn in our application prior to April 9th for feedback?
A:  Applications may be turned in prior to April 9th but we will not provide feedback on applications. We strive to give all applicants exactly the same information, so that no applicant receives information from us that gives them an advantage over others. Please ask all questions prior to submitting your applications, and we will publish the answers in this document on our website for all to see. 




17. Can adults whose first language is a Native American Tribal language be served through an ESL program?
A:  Yes. ESL Programs are for any student who is less than proficient in reading, writing, and speaking English. Students in our ESL programs speak a variety of first languages. 

18. Can you provide a definition for "Secondary school credit" under the Programs for Corrections Education section?
A: This term appears on page 44 of the RFA, within the narrative prompt for Programs for Corrections Education and Other Institutionalized Individuals, Sec. 225. The term appears within a list of sanctioned program activities under this section. In this context and given current options available to adults in New Mexico, the term “secondary school credit” should be understood to refer to the activity of preparing learners for one of the two state-approved high school equivalency tests in New Mexico (GED and HiSET) with the outcome of students earning a state-sanctioned HSE credential through passing one of these tests.  
19. Since we a federal institution, we don’t believe we have financial statements or independent audits done.
A:  You must submit financial statements or independent audits to satisfy this requirement. Please contact Cesaria (Cia) Padilla directly regarding program-specific issues in obtaining this documentation, as soon as possible. Cia’s contact information is listed in the RFA. 

20. May we remove/delete any sections, i.e., Corrections question, if we can't or don't plan to apply? Do you prefer we leave these questions intact and note N/A?
A:  Programs may remove either of the two OPTIONAL questions only if they do not apply to their program application (i.e.: Corrections; IELCE program).  All required sections and narrative questions must be included or an application will be disqualified and not considered for funding.  

21. In the previous RFA, New Mexico State University had an extensive audit. Is there consideration for this?
A:  In the past, the branch institutions of the large Universities (UNM, ENMU, and NMSU) submitted one audit for all those applicants. Though they are extensive and many of you may attach the same one, we do still require that they be attached to your application. If this response does not answer your question, please let us know.
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22. Sorry I wasn't able to join yesterday's meeting. Is there any way I could join the meeting?
A: The meeting recording will be posted on the New Mexico Higher Education Department website.  You will find it at this link: https://hed.state.nm.us/students-parents/adult_education/2021-request-for-applicants-rfa.  It should be posted later today.  All further information about the Request for Applications will be posted on the website and you may continue to ask questions to the adult.education@state.nm.us email address.

23. May we just paste in a link to the financial reports, or should we download and attach the financial files?
A: Modified answer – 3/18/21: We know that some branch campuses of universities have financials accessible via link. These financial documents are for the entire university system, are very long – over 100 pages – and may be difficult to append to your application or cause trouble when you try to email the application to us. If this is the case for you, you may paste the link to the financial report into your application. Please make sure it works. If this is not the case for you or if your institution’s financial reports can be separated out into shorter branch campus reports, please download and attach the program-specific or campus-specific financial files to your application. 

Received:  Friday, March 12, 2021
24. On page 25 of the RFA you ask for the following information: 
“Describe how your program has historically met state-adjusted levels of performance for the primary indicators of performance described in WIOA Sec. 116.”

Would you provide a link to those state-adjusted levels for the years under consideration?

A: My answer to this question has two parts. First, as you respond to this item, it is acceptable to refer to the FY 22 levels of performance for each of the performance measures. All of this information is in the chart on page 25 of the RFA. In other words, you may discuss how your program has historically met or exceeded (or not) these levels of performance as a reference point. We know that you did not have these levels of performance as a reference point in the years prior to 2020, but you may still discuss how your program performed on each of these measures and compare that performance to these FY 22 levels.
The second part of my answer is as follows: The NM WIOA Combined State Plan 2016-2019 may be found on the Department of Workforce Solutions (DWS) website. The performance goals for the core programs for those years are available here: 
https://www.dws.state.nm.us/Portals/0/APPENDIX_I-Performance_Goals_for_the_Core_Programs.pdf
As you will see at this link, the only specific state-adjusted level of performance listed in that former state plan for adult education is that provided for measurable skills gains, or MSGs. All other levels of performance for adult education in that plan are listed as “baseline”; that is, OCTAE was at the time still in the process of collecting data on these performances measures, to establish a baseline from which to negotiate future target levels of performance  Therefore, you may also choose to refer to the MSG performance level listed for adult education in that document as you discuss your program’s past performance. 

Received:  Sunday, March 14, 2021
25. If our agency is not going to provide Integrated English literacy and civics education, do we complete section O. CONSIDERATION 13 Sec. 231(2)(c)(13) ?
A: Every applicant must respond to all required items in the narrative section of the RFA. These required items are lettered A-P. The optional items in the narrative are letters Q (IELCE Program funds) and R (Programs for Corrections Education and Institutionalized Individuals). If you are not completing section R and applying for IELCE program funds, we understand why you may be asking whether completing section O is necessary, since that question asks applicants to address the need for English language and civics education programs in the area(s) in which your program is located.  However, this question is relevant to all applicants because English language acquisition activities are one of the allowable activities for all AEFLA subgrant recipients.  (Section Q and IELCE program funds are more restrictive and require such activities be offered in the context of integrated education and training.)   Because the need for English language acquisition activities is widespread in New Mexico, and because activities are both allowable and supported AEFLA activities, all applicants are required to respond to Section O.

26. From your past experience, are we supposed to write the RFA with the text as part of the RFA, or with the text as a stand-alone document?  I was assuming that the text was incorporated into the RFA document, but then I read on page 20 that they want the responses lettered.
A: We prefer that you write your text into the RFA, which is a Word doc. In other words, just make the space you need after each lettered item and answer it with as much space as you need (up to the word limit). This will make it easier for reviewers to score the items and be sure they are scoring the correct item. The first page of your application should be the cover page for the RFA.

Received:  Wednesday, March 17, 2021
27. When checking our past data, it is not broken down specifically by Reading, Writing, Math. Those seem to be all included in the ABE levels. We have data for our ELA that is separate. I was wondering how to input this data into the separate categories.
[bookmark: _Hlk67042430]A:  Please see the informational document from LACES (Appendix A, at the end of this document) that has detailed information on how to access this information from LACES for the RfA. 

28. I am looking to obtain the following information for FY 17/18 and what NRS tables I would need to use to find it.

Measurable Skills Gains – 
•	Number of Participants who exited
•	Number of Participants who exited achieving outcome
•	Percentage of Participants achieving outcome

I think this information is in Table 4, but I can’t determine exactly which numbers to use.  Can you assist?  Please advise.

A: This information can be found on NRS Table 4.  Please see Appendix A for more information about retrieving LACES data for the RfA.  

29. I am working on Section 9 of the RFA and am wondering if the documents provided in the link below fulfill the requirements. Here is the link:  https://af.nmsu.edu/financials/.  Let me know if this is what you are needing.
A: Yes, those files at that link are correct. They contain the most current financial statements for NMSU.  They would meet the requirements. Since the documents at the link are for all of NMSU and are very lengthy, you can list the link in your RFA.
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30. NRS table 5 is used to complete the tables on pages 27-29. NRS 5 is blank for Corrections. LACES only populates with non-correctional/institutional NRS participants who meet the criteria. What should New Mexico Corrections Department do for this?
A:  For Correction Education Programs please utilize TABLE 10. TABLE 10 is: Outcome Achievement for Participants in Correctional Education Programs. 

31. On page 11 one of the outcomes is 'Transition to postsecondary education and training' . We don't track this in LACES. I could pull the participants out of LACES for each FY and see if they match up with inmates enrolled in postsecondary in our system. The unique student ID in LACES is our NMCD #. Our business rule is they need to have a HSD or equivalent to take postsecondary classes.  Of course it wouldn't pick up anyone who released and then enrolled in postsecondary education.

A: The state office does data matches with the Higher Education Institutions only in New Mexico. If the learner has exited Adult Education within one year, that is the criterion for them to be on TABLE 10 for Corrections. If you have information that the student left and transitioned to postsecondary classes within one year, please include them in your data.



Received:  Friday, March 19, 2021
32. I would like to clarify what is meant by exited within one year. For example to appear in Table 10 for FY 18/19 would the student have exited the prior year e.g. between 7-1-2017 and 6-30-2018 and enrolled within 12 months of that date?   I want to make sure I'm searching for the correct cohorts in our records. If you could provide an example that would help. Corrections students are mostly enrolled in post secondary education through Mesalands Community College and Ashland University which are based outside of New Mexico.
 A:  For example: if a student exits the program on 9/30/2020, the follow up data dates would be from 10/01/2020 until 9/29/2021. 
We do data matches with NMHED’s Institutional Research Division, which all higher education institutions (HEIs) report to. We are dependent upon the data that HEIs report to the Institutional Research Division. Mesalands Community College is a New Mexico college located in Tucumcari, NM, and will be included in the data match we do.


33. We have a few questions regarding the information being requested from the table under #2:  DEMONSTRATED EFFECTIVENESS

· Under the column “Participant Outcomes”, where are we to pull the information from LACES for “Writing” as this is not a tested area on the TABE 11/12 test? Or is this the “Language” subtest of the TABE 11/12?
· For “English Language Acquisition”, are we reporting data for as a total for all areas? (reading, writing, total reading & writing?).
· For “Employment”, what information from Table 5 is needed; employment 2nd quarter after exit or employment 4th quarter after exit?

Thank you for your guidance.

[bookmark: _Hlk67042467]A: Please see the response for Question #27 and Appendix A for further information on pulling information from LACES for the RfA.  For employment, the information on Table 5: Employment after 2nd Quarter and Employment after 4th Quarter are needed.  

34. I hope you are doing well. I have a quick question. Do you grant extensions under special circumstances? I only ask because we will be getting a new AE Manager on April 1st, and I’d like her to have time to review the completed RFA before submitting to admin for approval (which may take a few days to review), and then on to you for consideration. I understand if it is not allowed but I figured it would be worth asking since the upcoming AE Manager will be responsible for answering any questions that are asked during the review process. Have a great weekend.
A: Unfortunately, no, we cannot grant any extension on the application due date. We understand your circumstances, but we are obligated to maintain the same deadlines for all applicants. 

Received:  Sunday, March 21, 2021
35.  On pages 60-64 of the RFA there is a Budget Backup and a Supplies and Materials Addendum. Do we need to fill out separate ones for State and Federal? 

A:  Yes.  Please copy the budget pages and complete separate forms for Federal, State, and, if applicable, IELCE. 



Received:  Monday, March 22, 2021
36.  The Appendix A document provides instruction on how to extract the information from LACES however how the data breaks down on the NRS Tables does not match up with what the table below (demonstrated effectiveness table) is asking.  
• There is no TABE 11/12 testing for “writing” so there is no data to show level gains in this subject area.  Should the 3rd row in the table below say “Language” instead of “Writing”?  
• I am assuming then based on your answer below we can change the table that is within the RFA to meet all the information needed.  Since there is only 1 row for Employment, can we add a 2nd row to show both 2nd quarter & 4th quarter data?
• Also, there is just 1 row for English Language Acquisition however the data that comes back from LACES is broke down into “Subtest Reading”, “Subtest Writing” and “Total Reading & Writing”.  The Appendix A document does not indicate how we should show this information in the table below.  Can we add rows to this as well to show the gains in ALL 3 areas? 

Thank you for your time to answer our questions.  

A:  NMHED seeks as many applicants as possible for this competitive grant. We want to be inclusive of all potentially eligible providers, whether or not they have been previously funded under Title II of WIOA. In this table, you may choose to report your data in the way that your program has collected and analyzed it over the last three fiscal years. For the purposes of this table, we are not concerned with whether the data was reported on an NRS Table. However, we have provided instructions for programs who use LACES in order to assist in providing the data requested for demonstrated effectiveness.  You may add rows or adjust the table as needed to reflect your program’s demonstrated effectiveness data.  In or under the table, describe the metrics and outcomes you are using so that we can understand your data. Remember that your response should help equip us if we choose to examine your data.

37. In section E, on the State Adjusted Levels of Performance table for FY22, can you please clarify what Credential Attainment means? Does this include any students earning a secondary diploma and/or any postsecondary credential?
A: In the chart in the narrative prompt in Letter E, Consideration 3 on page 24 of the RFA, the FY 22 Expected Level of Performance for Credential Attainment Rate is listed. If you then scroll below to the charts on pp. 27-29 that you will fill out for this item, the relevant credentials are separated out and described in more detail. If you have questions after reading the four types of "credential" listed in these charts, please do not hesitate to write back to us.
Received:  Wednesday, March 24, 2021
38. I have a question regarding the Demonstrated Effectiveness table on page 11.
The table refers to a “Percentage of Eligible Individuals Improving Skills or Achieving Outcome” for the purpose of calculating these percentages, would it be appropriate to use the grand total of column B on Table 4 if we are pulling the information for this from Table 5 for that fiscal year?
With that said, would it be out of the ordinary to have an employment percentage above 100% for a particular year?
[bookmark: _Hlk67492387]A: No, that would not be appropriate. For an explanation of how to get this information from LACES, please refer to Appendix A on the Q&A on the NMHED website for instructions. If you still have questions after reading the Appendix, please let us know. Please also remember that this table on Page 11 is so that we know your program is a program of “demonstrated effectiveness.”  Report the data in the way that you have collected it and explain to us how you are reporting it. It is okay to add lines to the table or write in explanations below the table to help us understand your data. Yes, it would be out of the ordinary to have an employment percentage above 100%. The employment percentage can be taken directly from TABLE 5.

Received:  Thursday, March 25, 2021
39. Page 52 of the RFA says, "Please complete the proposed budget page for each funding source separately: State, Federal, IELCE."  This is followed by a Budget Proposal Form with gray shading and then two Budget Approval forms with yellow shading.  These are then followed by the Budget Backup forms.  Am I correct in assuming that for each funding source: State, Federal, and IELCE, we should submit one Budget Proposal Form, one Budget Approval Form, and one set of Budget Backup Forms? 

A: You are correct. You should submit a separate set of forms (one budget proposal form, one budget approval form, and one set of budget backup forms) for each funding source you are applying for.  

40. On page 11 it requests: Transition to postsecondary education and training. On pages 27-29 it requests: Attained a Secondary School Diploma/Recognized Equivalent and Enrolled in Postsecondary Education or Training within one year of exit. Are these the same but just worded differently.

A: You are correct that both of these items are asking for the same data. Remember that there are two tiers to this application. The table on page 11 helps us understand whether yours is a program of "demonstrated effectiveness". If you do demonstrate effectiveness, then we will go on to score the remainder of your application. That is why this data is requested twice.

Received:  Friday, March 26, 2021
41. In finalizing our budget forms, I know we need to fill out one proposal form and one approval form for each index, STATE, FED, IELCE. Do you want ONE budget backup sheet that disaggregates and then combines the three, or again, one backup sheet for each index separately? In the past I see that our previous director has combined at least the FED/State on one backup document.

A: Please review the RFA for this process.  Every grant you apply for has to have a budget backup.  The question is also answered in the Q & A (see question 39).  

42. Percentage of Eligible Individuals Improving Skills or Achieving Outcome: Just wanted clarification:  Because you are asking for a percentage, what do we use as the denominator?  The directions from LACES give us the numerator and I am assuming that the denominator is the number of students who took the test in that subject.  In other words, we do not use the total fundable for the year, correct?  Is the denominator only those who post tested or everyone to took the pretest?
A: The denominator is the number of students who took the test in the specific subject area.  We don’t use the total fundable.

43. Our CFO sent me PDF copies of our last two audits, so can we attach our copies of our two most recent audits as attachments to our email when we send in our RFA, or do they need to be scanned to be included with our RFA in one document?
A:  Ideally, they should be all in one document but that can get cumbersome to send in one large file.  If it is too large to send as one single document, you may send them separately and we will combine them into one document on our end.  


Received:  Monday, March 29, 2021
44. There appears to be no numbered section 7 in the document, and the headings in the version I have on page 6 don't match up to what I have in the packet.  Page 6 number 4 is 'Services to be Provided' but in the text of the document, labeled #4 is "Funding Application Narrative".

A: The numbering is off because the first thing on the list (Signed Cover Sheet) does not have a number and throws the rest of the items in the body of the RfA off by one.  We will be sure to fix that in four years when we issue the next RfA.  

45. Every time I work on the proposal, MS word asks me if I want to update it with the version you have posted online.  I haven't done that.  Are you changing the version online, and do we need to connect to you and update?  Is that why my numbering on page 6 of the packet doesn't match up to the application? 

A:  This has to do with the hyperlinks within the body of the RfA.  MS Word will ask if you want to update them each time you open the document.  It does not have anything to do with the numbering issue.  That was our fault for not catching sooner that the numbers did not match.
The version of the RfA that is posted on the NMHED website has not been changed since the Word version was posted.   

Received:  Wednesday, March 31, 2021
46. This question is in regard to page 86 of the RFA, Supplies and Materials: Addendum for Federal Funds:  Do we need to complete an addendum page for State Funds?

A: If your program plans on using any State funds for supplies and materials, then please complete an Addendum for state funds as well. Change any heading or indicator to make sure it is clear which source of funds the Addendum refers to.








47.  We are working on the Budget Forms and noticed on the RFA questions (#39) that we do need to complete all three budget forms (Budget Proposal, Budget Approval and Budget Backup) for each funding source: Federal, State and IELCE.  The Budget Approval Form (with yellow shading) is printed very large as a “landscape” document, and has part of the form missing.  This form is usually submitted once we get a grant award, it contains the same information as the Budget Proposal.  Would you please make available all the budget forms in “portrait” so that we can complete them?

[bookmark: _Hlk68092076]A: It appears that the formatting for part of the budget sheets became slightly skewed when it was posted on the website, even though it does not appear that way in the original document. In your own copy of the document, you can pull the corner of the table slightly the left, which should center the table enough to use it. We will not be able to provide the form in portrait mode ourselves, but if you are able to make this change yourself, you may do so.

Though it is my understanding that past RFA budget also required the Budget Approval Form, it is required this time. 

48. What is the percentage allowed for “Administrative costs” on the federal grant?

[bookmark: _Hlk68092091]A: Administrative costs are capped at 5%, as per WIOA Sec. 233, Local Administrative Cost Limits. This year, we will be negotiating the administrative costs with each individual awardee.  

Received:  Thursday, April 1, 2021
49. Does Section P refer to programs that currently operate as a one-stop location as part of their overall service portfolio, or does it refer to a local program's interaction with the local one-stop provider? 

A: Section P should be filled out by all applicants. It refers to how the local program fulfills their responsibilities as a one-stop partner under the New Mexico WIOA Combined State Plan. Those responsibilities are outlined in the required narrative for Section P.

Received:  Friday, April 2, 2021
50. Can a designee sign for the Executive Officer of the Organizations? (i.e. Deputy Cabinet Secretary sign for the Cabinet Secretary)

A: Yes, a designee (such as a Deputy) may sign for the Executive Officer of the organization, but only when the Executive Officer themselves is unable to be reached or on leave. Whenever possible, it should be the Executive Officer. 
Received:  Monday, April 5, 2021
51. Hi, we are seeking further clarification on question #42 that was submitted by someone on March 26th. The question states "Is the denominator only those who post tested or everyone to took the pretest?" The answer still does not specify and only says "...number of students who took the test in the specific subject area." 

In talking to some different AE directors and data techs, it seems as though this is being interpreted differently as some are using posttest numbers for the denominator and some are using total number of pre-testers. To us, it seems a better measure of program effectiveness to use total number of students that pre-tested in the subject area regardless of posttest status. We think that is what your answer is stating but want to be sure.

A: The answer is the number of students who pretested in the specific pretest in that subject area.  I hope this clarifies better. 

Received:  Tuesday, April 6, 2021
52. Does a MOU with a workforce partner need to be signed or can one be added to reflect that it is still being worked on?

A: It would be preferable for the MOU to be signed before you submit your application. However, if this is impossible for whatever reason, please feel free to provide the MOU you are working on, along with some information about where you are in the process and when you expect it to be signed. This will help with context as we evaluate the application.
Received:  Wednesday, April 7, 2021
53. As a new applicant, we are not too familiar with how the budget works. The RFA mentions to complete a budget form for each funding source: Federal, State, IELCE. Can you expand on this please? Our understanding is this was a State funded program so we should only be completing the State budget forms?
[bookmark: _Hlk68687927]A:  This is a federal grant under Title II of WIOA that includes state maintenance-of-effort funds. As such, each applicant must include a budget form for each funding source that is associated with the grant - at the minimum, one form for federal funds and one form for state funds. If you are applying for the OPTIONAL IELCE PROGRAM funds, you would also provide a budget form for that program. 
The amount to budget on each form and in each category depends on the number of students you anticipate serving and the amount you are requesting.  You must be sure that you have enough budget to compensate instructors along with any other administrative staff you feel you may be using.   There is a separate line for data technician that needs to also be taken into consideration as you will need to enter data at least monthly.  There are budget lines for purchased services which can include outside contracts for your program or items that you feel need to be purchased for the day to day operations of your program.  Supplies and materials is also included so that you have all the necessary tools for your students and your staff.  Although travel is not at the forefront these days (COVID), you may still budget in that line item to take care of conference fees (virtual or in person) or any trainings you may send your staff to.  Equipment is budgeted to take care of the computer or IT needs for your program. 
Because the state grant reverts at the end of each year to the General Fund for the state of New Mexico, we encourage all programs to spend down all their State grant entirely each year.  While we realize this may be difficult, especially as in years such as we just had, priority should be given to the State grant for expenditures.  We encourage programs to spend down as much as possible in both grants, but priority should be given to expending all of the funds you have budgeted for the State grant.  This may impact how you wish to budget for both the State and Federal grant. 

54. Following up on Question 47 regarding the budget forms. Does the applicant complete the Budget Approval Form or is that form completed by the Department after an award is made?
A: Yes, please fill out the Budget Approval Form based on the amount you are requesting.  If and when you are awarded funds, you will fill out another budget form based on the actual award and informed by the original budget you submitted. 

55. Can we submit the RFA using electronic signatures? 
A: Yes, you may submit the RFA with electronic signatures.








Received:  Thursday, April 8, 2021
56. On page 11 of the application, there are two rows labeled as the following:
	Attainment of Secondary School Diploma or its recognized equivalent 

	Transition to postsecondary education and training 



Table 5 in LACES appears to combine these:
Attained a Secondary School Diploma/Recognized Equivalent and Enrolled in Postsecondary Education or Training within one year of exit ***
Table 4a in LACES has a column labeled:
Percentage Achieving EFL Gain by Transition to Postsecondary Education
I am assuming that achieving EFL gain by transition to postsecondary education in 4a is difference from what appears in Table 5.   My notes, reflect using Table 5 data to complete this information on page 11 of the application, but the wording is confusing.  Should the two rows of the table on page 11 noted above be combined? 
A: In order to find Attainment of Secondary School Diploma or its recognized equivalent It comes from Table 4 (F).  In order to find Transition to postsecondary education and training, it can be found on Table 5.

57. Please clarify the following: Please complete the proposed budget page for each funding source separately: State, Federal, IELCE.

We are to submit a separate budget for 001 Federal: WIOA (Sections A-P in the Narrative)
002 State: Department of Corrections  (Section R in the Narrative) Optional
003 IELCE: Literacy and Civic (Section Q in the Narrative) Optional
Is that correct?
A: No, the way you understand the budget is not correct. This is a federal grant under Title II of WIOA that includes state maintenance of effort funds. Please include a budget form for how you will spend the federal funds and how you will spend the state funds. The IELCE Program and Corrections Program are both optional. You would only submit a budget for IELCE if you are applying for those optional funds. 
 
The answer to this question is in the Q & A form on the website, but since today is the deadline, we will reproduce it here:
The amount to budget on each form and in each category depends on the number of students you anticipate serving and the amount you are requesting.  You must be sure that you have enough budget to compensate instructors along with any other administrative staff you feel you may be using.   There is a separate line for data technician that needs to also be taken into consideration as you will need to enter data at least monthly.  There are budget lines for purchased services which can include outside contracts for your program or items that you feel need to be purchased for the day to day operations of your program.  Supplies and materials is also included so that you have all the necessary tools for your students and your staff.  Although travel is not at the forefront these days (COVID), you may still budget in that line item to take care of conference fees (virtual or in person) or any trainings you may send your staff to.  Equipment is budgeted to take care of the computer or IT needs for your program.  
Because the state grant reverts at the end of each year to the General Fund for the state of New Mexico, we encourage all programs to spend down all their State grant entirely each year.  While we realize this may be difficult, especially as in years such as we just had, priority should be given to the State grant for expenditures.  We encourage programs to spend down as much as possible in both grants, but priority should be given to expending all of the funds you have budgeted for the State grant.  This may impact how you wish to budget for both the State and Federal grant.

Received:  Friday, April 9, 2021

58. My question and confusion is around the request to "Please complete the proposed budget page for each funding source separately: State, Federal, IELCE"   We have no guidance or understanding of how to separate these funding sources.  Please provide specific instructions for separating our complete budget request into these categories.
A: NMHED does not detail the state's maintenance-of-effort requirements in the RFA. The state legislature awards NMHED funds each year as part of the state's maintenance of fiscal effort requirements under AEFLA. Please use the guidance we have already provided in our previous email and in the Q & A to determine how you propose to budget your federal and state funds. You are correct that you will fill out two budget forms. We want to be clear that one is for your use of federal funds and one for your use of the state maintenance of effort funds. Combined, these two forms will reflect your entire budget for these grant funds.

59. “This is a federal grant under Title II of WIOA that includes state maintenance of effort funds”  Please indicate where in the RFA, NM shares its MOE Maintenance of Effort percentages and requirements.  If we know what the percentage is, we have multiple leveraged resources and believe we can meet the requirements, but as an organization who has no experience with this funding stream we have no guidance on meeting the standard.  At this point, we now understand that we will complete the budget section twice.  One with the requested/proposed funding.  And a second copy with our matched funds outlined. Is this correct?
A:  NMHED does not detail the state's maintenance-of-effort requirements in the RFA. The state legislature awards NMHED funds each year as part of the state's maintenance of fiscal effort requirements under AEFLA. Please use the guidance we have already provided in our previous email and in the Q & A to determine how you propose to budget your federal and state funds. You are correct that you will fill out two budget forms. We want to be clear that one is for your use of federal funds and one for your use of the state maintenance of effort funds. Combined, these two forms will reflect your entire budget for these grant funds.



Appendix A

IETP Enrollment and IETP+NRS Participation
To find students enrolled in IETP in FY 20/21, click 'Add Search' (above the student grid):
· In the 1st box, type 'ietp' and under Class Enrollments click 'IETP'
· In the 2nd box, select 'contains'
· In the 3rd box, type 'ietp'
· At the end of the row, click + (plus sign) to add a new row
· The new row will have the operator [AND], leave that as is
· In the 1st box, type 'star' and under Class Enrollments click 'Class Start Date'
· In the 2nd box, select '>=' (greater than or equal)
· In the 3rd box, type or select '07/01/2020'
· At the end of the row, click + (plus sign) to add a new row
· The new row will have the operator [AND], leave that as is
· In the 1st box, type 'end d' and under Class Enrollments click 'Class End Date'
· In the 2nd box, select '<=' (less than or equal)
· In the 3rd box, type or select '06/30/2021'
· Apply

This will return the students with an IETP enrollment in FY 20/21.

To find NRS Participants with an IETP enrollment you can run NRS Table 3 by going to Searches > NRS > NRS Table 3 > Select Reporting System.  There is an IETP breakout for each program type. 

NRS Participant by FY broken down by Gain Type
First you'll want to find students who were NRS Participants in the FY for which you are searching. Go to Searches > NRS > NRS Table 4 (Replace) > Select Reporting System.  Starting in FY 18/19 exclusion reasons were allowed, take note if you have students in Column C (Total Number of Participants Excluded from MSG Performance). 
· Click on the Total in Column B.  
· If you have students in Column C, go to Searches > NRS > NRS Table 4 (Add) > Select the same Reporting System as you already did for Table 4.
· Click on the Total for Column C.  It will load with an [and] operator in front of the 2nd search tile. Click the [and] once, it will become [and not]. This will leave you with the number from Column B minus the number from Column C.
  
Once the students have loaded in the grid, go to Reports > Level Gains > Select the same Reporting System as you did for Table 4 > Print Excel.
The Level Gains report shows a row for every subject that was posttested even if there was no gain.  As a result, a student may appear on the report multiple times.

Once you open the report in Excel, you have to make some adjustments to formatting so you can sort the report.  

· Highlight all the data by clicking the left corner between Column A and Row 1
· On the Home tab, in the Alignment section, click the 'Merge and Center' button to unmerge all merged cells
· While everything is still highlighted, in the same section, click the 'Wrap Text' button twice to unwrap any cells that were originally wrapped
· While everything is still highlighted, on the Home tab, in the Cells section, click Format > AutoFit Column Width and then Format Row Height > 12

Now you can delete any blank columns (typically B,D,G,H, M)

Highlight all the data again, go to the Data tab, in the Sort & Filter section, click the Sort button
Sort by Column A (don't check the 'My data has headers' box)
 
All the header rows should be at the top and all the data should still be highlighted
· On the Data tab, in the Data Tools section, click the 'Remove Duplicates' button
· In the resulting window, all the columns should be checked and the 'My data has headers' box should not be checked > click OK
· Now the duplicate rows are gone. There are still some extra page number rows at the bottom of Column A, since the Agency is the same for all, you can delete Column A and you'll also be rid of all the page number rows.
· On the Data tab, in the Sort  Filter section, click Filter
· On the Level Gains column only select the 0 (zero)
· Delete all the zero rows. These rows represent subjects in which a student was pre and posttested but no gain was made.

Once you're done deleting, clear the filter so the remaining data displays
· Go to the Insert tab, in the Tables section click 'PivotTables'
· In the new window, leave all the selections as is and click OK
· This will create a PivotTable in a new tab
· From the PivotTable Fields pane, drag 'Subject Area' to the 'Rows' area and drag 'Student ID' to the 'Values' area.  It should say 'Count of Student ID'.
· Now you have a count of gains by subject.  It is not necessarily a unique count as a student may have made a gain in more than one subject.

Repeat for each needed fiscal year.
For all Employment, PS Credential, and PS Enrollment numbers, you can just use the NRS Table 5 for that fiscal year.



